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I—=FIREDTRTDARY M VEREOEF OrmslE, HAL
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2h—2FFT

2h—>. 2RBEZLHEEA (IMD) 49 (F14+F2)
2007 FuZ ATEFORAEIZE > THEL A2KREArmsil,
E—2 « 27 7 Apisrid, IMDEG & e SE§, Hfri
dBc,

2h—=> 2RMEEZHEA (IMD) &2 (F2—F1)
2007 Fu T ANEFORAITE - THEL 52KFE Armsfit,
E—2 « 27 7 Apsrid, IMDE & e SE$, Hifri
dBc,

2h—>, SREEEHEEHA (IMD) B9 (2F1XF2)
2007 F a7 ANEFDREIZE > THEL A3KFE Armsil,
¥—2 « A7) 7 A5, IMDES E A s E§, HIE
dBco

2h—>, SREEEHEEHA (IMD) B9 (2F2%F1)
2007 FaF ANEGTOREIZE o THEL A3KEArmslH,
Y—2 « 27 7 25t IMDE & e SN E§, B
dBco
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2~ —>WoSpur (ZOMOREXTT X)
QREAFDRIREABS & ZEERE, 22007 Fa 7 A
BHOREICE > TELLEAMSE, ¥—2 - A7) T AR
i3, IMDET & AR SN FEH A, HifZiddBe,

2h=2  2RAHDAE =T - K142 b+ (IIP2)
A N=F DT NAT = AJIEF 737 — 52 KIMDJE 55 D
12%5 7, BEf7iZdBm,

2=, BRAHDA>E =T - K142+ (IIP3)
TUN=F DT VA — )V ATEF /3T — 7 53KIMDE D
12%51\ 74l HALIZdBm,

2k—>. SFDR

WERDR—HFDATI b= DOrmsfie ¥ —2 - 7Y 7 A5
Omsfik DI, ¥—2 - A7) 7 A5 iE, IMDES & 134
HRENFH A, HALIZdBe,
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EN{FIRIE

FIFOFFMi AR — Fid, EEORBK THE SN TWE T, %0
BIZADCO DTV F ) - T— % OYUEICEE R %E %2 F7- L
TBY, PCHREFOTF—7 %7 v 70— LTI TEXS5 L9112
LEd, R+ v ME, IDTOIDT72V283 FIFOF v 7' %
N=2ZLTWET, ZOFFli~ A 7 4 I1ZHSC-ADC-EVALA-
SC FIFO%fH L T, i KI133MSPSOEETT I ¥ )L - 7 —
Y ERIETE, Iwk32kBOT— % # 1M T & £ 9, 2l DOFIFO
F v 7% FOHSC-ADC-EVALA-DCx2ffi [ 31X, 727V
ADCORE, & 2 W IF133MSPS & O v > 7)) o 7 %
LDOADCHLDTYIVF T LI AENT2T— 5 OFHEHNTE &
¥ ADC Analyzer& O#fFHICUSB 2.0% A 712> ba—
TIEAENTWAIH, USB 2.0 (USB 1.1& Hifr) 1~
Yy —T 1 —AEffioTHF LIy Ea—F ICflHEICERTE T
o

FIFOF v 7~OHEAKMIE L Z D7 — & OFH LI

BEDAT v T%%ETT, £9. ADC Analyzer’’FIFOT v
TNOEAHUE AL L E 5, FIFOF v 7id, v A% — -
J+xv MEF (MRS) Tty b&hEFd, §4&, USB~
A1 ay bu—7ORMEA TS, USBIREGD T 7127
5DT, ADCANIZ/ A APRATHILEHD THA,
FIFOF v 75V o Wil 5 & FIFOF v 76D 7 ) - 7
FZ7IZED KIEFOUSBY A 703y +a— T H LB % R
L ¥73, ADC Analyzerit, #30msf4(Z7eH LR % Blds L £
T

S LA dux . FIFO1 (U201) Z 7213FIFO2 (U101) 205
DT — % OIS %155 0EA & OEBASHI#H L £ 9, 22 DFIFO
FuTOTF=7HNIEFEC1I6E Y b - =% - NRAZEEIT S
728, USBY A 703> Fa—J70EA & OEBES 2 ffi» T
IELWFIFOF v 776 7= % 25 A WA L) ITHREL T I,
TT)r =Y a oAb E, ADC Analyzer’SUSB~
f7uaryiu—7i2axry Fx%bY, IELWFIFOF v 77
SOFMLERBT A2, T3 727)V - FE—FhnwlA v

y—1) —7 - E— FTIE2DODFIFOF v 775 OFi L % G
LEd,

70y 7 DERA

Ny T 7 - AFYDEZEF v ANICE, F—% - FvTFvH

DAy ZESHPLETY, 2079y 715513, @HADCEH:

AR = FhoRftshn, 7= b dicarr 5J104/204

(Fx v F N1, FXoyFA23FEHI2EV3T) #HhLTHES

NFET,200F v VRNV TN -7y 7 LERL %
Gl Vv v RIB303Ic ko THR T E £ 4,

LVDS (REBEEEMES) Ly — O HIcH b Y v 731304
EI30512L 5T, Wiz ay 2 #ET&$¥, LVDSL ¥ —
WEaray 2 ORI T 7 4V F T,

BTF—=F - F Y RNDPEDY IV ROz Ay 7EFIE
Ny 7 IS, LVDSL ¥ — U301 D220 D4 — b THH)
CMOSTEFICEBmEINE T, TNIZLY, £EF v A VD 2
0y 7 E%#CMOS, TTL, F7/I3ECLIZTAZ LN TEF T,
sy 75513, 0.1uFa > F Uy TACH v 7)) v 7 s E T,
K5 ¥ a x—%DOR312, R315Tid, LVDS7 — DL &\
EDFENTE LT, LEVEDBMMENELE LT 7)) 7 —
TaryTlE, IRHLDRTF YL a A—% % L) KEWIEPi#EIC
BERZ CHBHALZILTS 2 LD TEET, HPIR303,
R304. R307. R308. R311, R313, R314, R316Ti, %%
B — MAO#H % A % #1.5VODCELEICHEL T,

MAZFFICIE, KT vy yax—=adhlsh7z0lINry - Uy
YRI310~J313% % ELE T, KT vy a A — 7%1¥fﬂtffﬁi
TS BINE, NS - VX R BETALENH Y T,

HEAHTHH ENTWAXORY — |+ - 7L AU30212 & b, FIFO
AEY) - FyTDrAy Y - SAHF — MEEREINTE T
o INHITHEDOFENTIEIAETTOT, HVFRIZY v 28
J314 L I31ISTHNANALE T, ¥ x 2813061307128 0
XOR7— b Cruv 75542 KETE2Ed, 774 )V bRED
P XORTF— N THOZ 0y 7 OKEEEH ) T4 A,

bk L7270y - NAT, ZFIFOX € - Fv 7 (U018
X U102, ¥ ~80) 24 LWRT_CLK1& WRT_CLK2fE 5 7%
wEDEFT, LDy I 3Iv T F T a T, AL T—F
ERY AL 720Dy T v 7RV PRS2 s
Oy 7 G ERTEE T,

yay Vil —%1F, SIBLO/ F7203S3CEEEHT
¥4, 2oruayy - YAl —%E, ADCIZz vy 7 %t
WBITADBDERLTRIINELZYFHA, Tho5D7Ty 7 -
INZIZACH » Y Y ZENDL 720, IEREY = L —% &l
MT& %9, DCN1 7 A%, R301/R3023 L U'R305/R306T
FRTE LT, B, J301£J302 (SMAZ A2 %), NI
R301. R302. R305. R306!I LIk IC I EHE STV
Ve, I FPEERTLLENSHD T,

DS90LVO048AEE) 7 4 >~ - L ¥ — 3% ffi> T, FIFOFHI
K= NI »SMEns 70y 755 LNV E2FETEE
o Zoruav s - LY=ol )iE, IDT72V283 FIFODH
IAH 7Ty 7 RIS 50, I ERLXORT — b - 4 A
IV E®RY £,

A1o8=)—=J - F=a20yOy*x>7
BEET—% - L= M2 72ADCIZ, Y ¥ 7Ny T 7« A
TY - Fy i (~133MSPS) DR E LRI A4 )
T3, 2HLATUN=F TR, T—F - FXY T TFXINELR
L= 2T EEE72012, =200 F ¥V AIVIZT
VFTIAEINTVDLHBENILHNET, COXHIHT T
r—<aryois. ADC Analyzerld2 20 F v ¥ A5 D
T—=F%A =) =T LT, B—OF v L& L TUHET
LYENRHY T, Fy A NIDLERANOY YTV, Fv >~
AN E2FHDY T LD ICIEFR I % T - 72
D, SNERZWOIEFCUHETLEHIICY TP Y 2T E2ERET
XFET (M. [ Fo TNy a—Fq4 7] 2B, Ny
Ty - AEVICEENLAMEIEKIZ, FIFOXEY) - Fv 7
(K1, U101B L T'U201) ~OFEAAA A =T VEF
(WENA, WENB) O T/N& 2L % iR A 12584 ST,
T =8 1 2OOFIFOICH ) AF N TH S b 9 1 2DFIFOIZ A %
HIZL T, WENAZ 15T AFIFOX WENB% 215§ %
FIFOl3., ¥ % »/8J401 LJA02DHEIZ L > TikE D T,
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ADC Analyzer®O4{ > X k—Jb

ADC Analyzerld, 7510727 « N4 L XDA/DI Y IN—F D
PEREZ $I1 3 CHHICEHEC S £ 97,

12X M=)V

ADC Analyzerid, FIFOsHififH ¥+ v M IZAHET 5CDIZID 5
NTVWET, TOVI NI TOT v TT— MO0 Tik, 7
Fus - 7N L XDOWebH A I+ (www.analog.com/hsc-
FIFO) #%# 728wy,

1. AnalyzerSetup.exe7 7 A V&= F FJ 4 7IZa¥—LF
j_o

2.9 NT YT - T T ANEEITTL A VA= - T g
F—FOBRICHKE-> THEMELET T, Windows
2000/Windows Me/Windows XP##ion~ » LTV 7 b
TITEA VAN VT BGAEIEREHRSLETT,

3. V7 b 2T A YA M-V LS, ETTRT 7 AV
(77 WV b+ ORI 8 P id c:\program files\ADC_
AnalyzenADC_Analyzer.exe) %347 L 3,

BRETTAIV

HET 71 )ViE, ADC Analyzer CfiH 9 % B ADCEHIH
R FTEIERTEE T, 2OT77A4MIE, ¥y M, 7
Oy 7@, 7=y FOBR (O 7 F2E204%)
7 & ADCEEfi I AR — R4 SFIFOEFH I A — FICE S h b
T=FIZB L, EERERE V7 by o TSR L 3, 3
JAR—=FIZLoTlX, €7 7 1 IVHADC Analyzer7 7 A )V
WZEEFNTWwET, ADC Analyzerx 28§ 5 7202, %%E
T ANERETELT 1Y Py BE TS, [Yes]Z 2V v
JLTCHRE7 7ANVEREL, L TV ADCIZHIET 5
T ANVEERLET,

T AN NOERET T ANONECRES B, [FFMIH A —
N DRI TH LVWEET 7 A VAR TE T3,

FHE A& — K DFRE
RDOAT v T1~5OFIMEIGE > T, ADCRFAliH A — FIZBI 5
BYT N2 TREERITVE T,

1. EEBOT VY v - 2= 2—% 5 Config>DUTODJIEIZ i
L F 9, [DUT Configuration] B [fi A F /R S FE o A
3 45ADCO % % [Device] ¥4 7O 7Ry 7 ZIZAIT L,
[Number of Bits]¥ 4 7227 K> 7 Z|Z¥ v b (ADCD
rfERE) AADNLET (ZOWHMEERORFHLET),
BET T ANORIEEE T 7 40 PUSMCETE T 51213,
[Default Data Directory] ¥ 1 7 1 27K v 7 212§ L\ WHT
AL, [OK]x2 2 v 7 LET,

27y 71

& DUT Configuration

EEX

Nerice ]Unknown
1
Murnber of Bits 14
Device Temperature]"C) 5
]C:\F‘rogram Filest\aDC_Analyzer  Browse..
Cancel

Device Number

Default Data Directory
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2. 7WFY Y - A= a2—775Config>FFT % #IRT 5 2, fi#
MRy voLnhitiz ) v 27 LT[FFT Configuration] [
Mz & Ed, TDA==2—"7T, [Fast Fourier Transform
(BE7—)2EM)] Juy MCHELET, LETHI
12, Channel AO TDA 7Y a v 2EHLTES LT v &
WESERLE T,

2Ty T2

CEX

=. FFT Configuration

Charnel Configuration

Selsct Channe! | ERCR NN~ |

Samples 16304 =
Averages 5

Encode

Frequency E5
[Hz)
FullScale Input

Power(dBm] 4

[~ Enable Fundamental Overide

—

Fundamental

Leakags(Bins) [10° " BinstoHz [39673Hz
onkogapins) 7
DC Leakage(Bins)[g
el

v Twas Complement

User Defined MR
Bandwidth Left |04
[MHz]

Bandwidth
RghtMHz 107
| 0K | Cancel

V7 b v = 7HOChannel AL, F#iiH A — FO TEOFIFO:
L OFIFOREH O F ¥ » 4 V1M Y4 L 4, Channel Bid,
S AR — F o EEOFIFO (Analog Devices® | T2 b ik
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W ?) BXUFIFOMBKEOF v > FIV2IHY L E 5, M
. [Vrox] 28 LTLESY,

FFTOE — EAREER A T2 3 > DEE

Samples | FFTORMEIIHE S W > VA BRIRLE T, 77 #
VMIZI6KBY » VT, Yo FNVEBET ) r—3va vz
Yo THERTEEY, VI Y27 ECEIRTELRAY VT
VEZ64kB T, 7272 L. FIFO#HtiH R — FiZ32kB FIFOT
HEESNTWwE T, HSC-ADC-EVALA-SCEF IV T » 7L
ADC% Ml 2358, BIRT IRy P VEDEFMH A — F
FEDOFIFOXEVIZ—FK L TWALENH ) $3, HSC-ADC-
EVALA-DCEF NV TF 2 7 VADC% ZF-li ¢ 284, AT~
TNVEIZETF v 2 AV DOFIFO A E ) I2—8 LT iairiuds
DERA (FXY U ANTEICERLLY Yy IV BINTE T
F)o FYNLFTL 7 AHFHDADC (AD94307% &) 1, FIFO
AEY)O2UEDOY  TVETHEHTE TS, [FIFOXE) D
Ty 77U —=F] aZBL TS,

Averages | ‘HFFTHREICHH T 2 0 cfaE L3, #f
flix, TADC Analyzer®#g| 2B LT 728w,

Encode Frequency (MHz) : ADCOY > 7Y 7 -0y 7D
WEX AN LET, 727 VADCHGFI T 854, 200574
Houay s - L—be ANTEET 0 HPELL WA,
T a7 EREERASIEL W EEFRRLE T,

FullScale Input Power (dBm) : iJJ 7 VAT — L% gt % 7=
DIZATCLELRE) R (ABmAL) 2BETEET, /4 X
EE L TIP2MP3DFHHETOAEH L £5

Enable Fundamental Override : ADC Analyzerid, H#jJiZ
WRAT )T A% AJIEGOEREEHZELET (F74V M)
7R, 77— avilioTiE, JloXT7 ) 7 AEHHK
ERLPZNUTORLR ) /NS TFa 7 AMEZE2MATE
Y. ZOF T a v TR, FHliICLEL/NS VT IS AT
E5%%ECT&¥¥, [Enable Fundamental Override]!|Z
Fxv 7 ~—2%f}% &, [Fundamental Frequency (MHz)]
Ry 7 AWEMIRY, ZORy 7 ACTHEEZRECEET,

Fundamental Leakage : S/NIt 3 L USINAD #5153 2% & &
WCEREZOWTU OB TERINLE YD, 728 21,
Iy a—F - L— FA8OMSPS., ¥ ¥ 7 VEA516384 L L TE
FEINTWALEA, 80M/21/(16384/21)=4883Hz/BinAS{&7E &
NTWET, BIRLZZY 1 ¥ FYBEBOBEICL Y, A1) —
yOF 7 x ) MdHE Y T4, FMlIZ. [Windowing| %%
LT3, 77 4 )V ME25, 10, 1iZZ 12 [Hanning],
[Blackman Harris]. [None] T,

Harmonic Leakage : [Max # of Harmonics]’K v 7 A T3 &
NIHERABFOKEREOVIT N LrOMTEMHSINIE YD
o BEINET 74V MEIZFHL T3,

DC Leakage : S/NH B X OSINADDFH I L 2w E >
(DCT) O, BHIET7 4 )V ME6EHAHL T,

Maximum Number of Harmonics : ADC Analyzer C#/R &
NDEREOE 77 4 )V MEIZ6T, FRTE D@k Ok
KEIF12TT,

Twos Complement : ADCFHifi R — F2> 5 D 7 — & 22D
BIRROBEIE, 20Xy 2 A F v 2 ~v—2 203 7,
ADCH N ORI OHMEEF 7y b - NMFVDEL 5
BRESNTVENIADCOT—% 2 — P2 L T2 8w,
[Twos Complement]4 7> 3 Y IZF = v 7 < — 27 HfFvTn
i, ADC AnalyzerldADC2 6 O x4 74 v b - N
1PV ERDT—s BB LET,

User Defined SNR Left (MHz) . S/NIL % T3 5 7212
LR HE RO LM FRE LA RO, 46072l
IFUDSNR EI:E, FFT7H Y FOF v 7 F v HICERE N
3,

User Defined SNR Right (MHz) : S/NIL% f§##i3 572912

L= FHPFEREWR B OLAMICTRE L2 EERO =, 16 h7-E

IZUDSNR L IEM, FET7 0y FOF v 7 F ¥ HRICEREN

3,

COYA Y N THET ) BB Tay N O+ Ty

EBekzlo, [OKZ227 ) vy 7 LET,

3. Config>Buffer CHSC-ADC-EVAL (A) % ®#UF3,
[Buffer Memory M TH A3 /R S L E 7,

27y 73

Buffer Memory

Current Buffer:

|HSC_ADC_EVALIA] |
oK  Cancel |

[OK]% 7 1) v 7§ % & [Buffer Configuration]” 1 >~ N7 2%
B & £ 9, ADC Analyzer?H#EWICUSBER 2L £,
USB##H o it 2z &, ADC Analyzerld /S 7 L IVIE#EIC
WHIELTWAIHN=Y 2 Y OFIFOR— R 2 b 0 & 1F
MLET, 2O, I ¥a—F &R T L
Wla#ERL, [OK]Z 2 v 7 LET,
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27y 73a

s Buffer Co... [= |[B)X]
[~ Part Selection ]
| LPT 1(04378)

| © LPT 2(m278)

[ USE Selection-
| @ USE [ 2MegBuffer
Select Device/Driver

Ok | Cancel
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4. Config>Bits >Data Bits®DJIFIZ:EIR L, [Bit Mask] & % [
&F¥, FFTOREICHHT A7 -2 ¥y bOKE Bt ik
i L i ‘j‘o

oy MR N Y DOREEL — T A L R LT
BV fis LT A S AR — FIZ§_XTMSBHi 2 1272 5 DT,
¥y 5 (MSB) 25JEHICI Y N—% DV v NEFITFTF = v
r=—=r%fFEd, 72721, AD9280, AD9281, AD9200,
ADR01 DB AIIHNN T, T D4DDADCOHAIL, ¥ v b
PB375IEICE Yy N2 F oy s <v—2 217 E 9,

v v 7 IWVADC#% EFili$ 4 & &1X, Channel A~ Channel AD
D@ By VRZTF v rx—2 % Ed, 72T
ADC#%Fili§ % & %1, [Channel Select] & (Config>
Channel Select) TChannel A & Channel BIZF = v 7 <v—27 %
5,

REV. 0

27y T4

=¥ Bit Mask Zl |E| le

i~ Bitz Used In Calculation

Select Channel |EEMEEE

Bit 15 [MSE)
Bit14
Bit13
Bit12
Bit 11
Bit10
Bits

Bits

Bit7

BitE

Bit5

Bitd

Bit3

Bit2

Bit 1

Bit 0[L5E)

B B i B B B B B i e e B B e e |

Ok Carncel
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TYNFTL 7 2ANELZADCEFEM T 5 & 1%,
Config >Channel SelectC[Channel Select] R 77 v 7"« X
=2 —% [T, [Interleave Data]’Rv 7 Z|2F = v 7 <—7
M E4, T9 35 &, Channel A& Channel BOT 5 A E
FRICEIRESN T T, 727 IVADCEMH T 5 & &1, FEAliRf
SOADCIZHIET A2 F ¥ VAV DA REIRL T4, AF— L
7 TRHGEIRE NS 77 4 )V b DF ¥ » 4 )VixChannel AT,

27y JT4a

3 Channel s... [ ][BX]

Select Channels ko Capture
[l Channels,

ChannelB

[ Interleaved Data

oK Cancel

04750-0-008.

Y7 b = 7 ®Channel Alx, 7R — FO TEOFIFO
(U201) B L UFIFOREEKOF ¥ » AV TIZHE L 5,
Channel Bid, #Fffil A — Ko _LEOFIFO (U101) (Analog
Devices® 0 T2H b\ b D) B X OFIFORIBEX O F ¥ >~ 4
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NW2ZHB L F 4, dEMiE, [Vx 8] 22RLTLEZ 0,
[OK1%2% 27 V) v 27 LET (Fv I BIROFIEICOWTIL,
[FSTNYa—F 71 7] 2BH),

5. RHEDAT v 7L LT, FVEFY Y - A= a—7bFile>
Configuration File>Save Configuration®JJ{IZ:#EIR L, 4T
MHTE2 L) ICHERZRELET . 77 AV LR %
BIRLCTT 7 A VERETFLET,

ZTOMDEREF T2 3>
BETNY T v - A= 2 — |2, 20135 ICWindowing,
Power Supply. Y-Axis% &EDF 7> a v HFHH) £,

Windowing

7 4 » ¥ % Hanning ¥ 72 (3Blackman Harris (77 #+ )V 1)
EERT L. vy FUBBEFTIZLET v Y FUH
¥Hanning ¥ 7-13Blackman HarrisiC2>WCld, [ 1 ¥ FU 4
Bl AL TL728w, [OKIZ2Y) v o7 LET,

. Select Windowing Func... E@

¢~ Hanning

¢ Blackman Harriz 4-Term

" Mone

ak. Cancel
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3. 71 > FUREHOER

[None] % #4135 & . [Coherent Sampling Calculator]™” 1 >~ F
v E I3 (K4zSHH),

&, Coherent Samp... Q@@

Choose One:

¢ Analog Input Frequency [MHz)

" # of Sinewave Cycles

[

Calculate

Exact Input Frequency Meeded:
| kHz

Integer Cycles:

0K Cancel
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M4, ab—L>b-HTYTH)Fal—4%

H) % al—yAELCHIET S X912, Config>FFTTIE L
W) TR E AT ALENSH D 3, [Analog
Input Frequency] (B8 L Z0fE) F721%[# of Sine Wave
Cycles] IR L T3, INNVDBWT AT UKy 7 AfE
ZAJIL., [Calculate]Z 2V v 7 LCav—L > NEikiize 3
RLET, Tb—L» MEEREFA 2V CERD) oL —
DRy 7 ACFRENET, [OK]1Z27 ) v 7 LT, #)Fa
L= %&#TLET,

Power Supply

Config>Power Supply CZ D+ 7 a % &, ADC7 )1
JEIEERE TV IVELBEOEE ANTEEYT (M52
W) T, BTSSRI S B 7207 T, AMEHIEIE B
D ¥ A, ADC Analyzerld, 7— ¥ D AEND &L 2D
WMEFIRL T3, ##HE. TADC Analyzerd i | # 2L C
{7280,

=, Power Supply Configuration E@

—
—

Awce Wolkage [Wolks]

Dwee Yoltage MWaltz]

] Cancel
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5. BEDERTE

Y-Axis

Y-Axisilifi ¢, FFT Y#iDO#F Rz E L £ 7. Config>YAxis
BERL, T AN ME-1302EFET LI LN TEFET, &
DT 7+ MElX, 14¥ v PADCO / 4 X - 717 (FFTOHE
FAAE S > TV $16,384) 10T 5 MBIH 258 T,

= Y Axis Configuration E]E]
FFT ' Min Axis 130
FET " Max Axis ,07

Ok Cancel
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ADIsimADCz &5/ L 7~ADC Analyzer®{ > X b —JU

ADC Analyzeri¥, ADISimADC%ffifI L7223 =L — FADC
DFHMH Y — v e LTHFIHTE T,

1A M=)V

YIalb—var.-v—)Iit, ADC Analyzer®fZ# 1 > 2
F—VIREIZA Y A b= ENF T (FHfliE. TADC Analyzer®
AV A M=)V 2BW), ZhoOEETHNTHAE. &
YLIBETN - T7ANVEHIb>TA Y AP= VL TBLLE
BHYET, FHTEL2ETNVET T TS - T84 £ XD Web
+4 + (www.analog.com/ADIdimADC) T35, LE% 3
UN—=F D [FHEFY — V] BRARTATLZEE N,

1. LT AHETINV - 774V %[Models]& VW) 74 L7 +Y
Wy u—FLEST, 774NV FOY T 10— NI,
[ c:\program files\adc_analyzer\models | T3,

2. FHA A= FIZEY 7 by 2 7B LT E TS, EF
Vo7 -7 2T AT 7200 =FY = 730
TH)FHA, VIMTZTOT v 77— M, HHoOE
TNRT v T TF— MENETIVE & D IZwww.analog.com
WCEHIMICAR SN TWE S, Webt A P 2 HHEIZTF = v
7L, BTELELDT 7 A VSR E THH 728w,

3. VINI 2T EETNEA YA M=V LTS, ETTRRT 7 A
W (77 + )V b OTE [e:\program files\adc_analyzer\adc_
analyzer.exe]) ZFETLE7,

BET AN

ADCEHi A — FEEH ST 2, G LHME, ¥ Iab—2var0
WICHETZ 7 ANE D= FI20EFHY FT, COBRET 7
ANIZE ST, BT 57— 5 ORI T 51EHe. v b
B, ruay s, 7=y boEX O8N ) 721320
WiE) HEoFEERE Y T M L TICRMETEE T, —HD
FSHIH AR — FOf%E 7 7 4 ik, ADC Analyzer” 7 £ VIZ&
FNnTwEd, ADC Analyzer&ifefh4 57202, HE7 7 1
WEIRETE2 714 PP EEd, [Yes]& 27 ) v 7 LT
HET T ANVEIREL, AL T 5ADCEHIH A — RIS Y
T57 7 ANVERIRL ., dFlE, TRl A — N o]
B TS,

ETFTILDERE
ADISimADC/N—F ¥ VEFliH A — FCHEHT2 V7 o =7
ERETDLIHEZ, ROATF Y F1~8%F4TLET,

1. 7V¥o - 2= a—775Config>FFT % #iRY % 2, 1T
BOBNARY %4527 1) v 7 L C[FFT Configuration] £
Za—%fE&FET, COYA Y FNYT, ZyI—F - L—
Mo N=FDPRETEAHLDL — MIHEELET,
ITya—F L= }+%ary—%OEEaEyoEicise
THE, EFVETREBY ICHEREET. IEL VRS
ENHLARNET, TOMOLELFEL T XTIV ET,
BRI H UL, [FEH AR — FOi%E] 2B L T 728w,
BEART L6, [OKIZ 2 ) v 7 LET,

2. A= a—»56Config>Bufferz#RL, Favy7yo -1
A b 5[Model] & #EIR L £ 3, KIC[OK]Z 27D v 7 LET,
ADC/7=% - *x¥7F v - N=Fv=TIlflboTZ®
ETIVHHERL X9,

2Ty T2

Buffer Memory

Current Buffer:

Il

1}

=

o

bl
04750-0-013

3. Model # #IRT % & /MW [Model] R ¥ >~ #Stop R ¥ » D
BEIZERENT T, [Model]Z 27 v 27 LT, ETIIVEIR
T —LEHETT,

2773

0-014

04750-

4. ADC Modeling 7 + — AT, ETMET % T84 ADEPR L |
ETIUADT F T AKOHENTE LY,

27y T4

=% ADC Modeling

Please select your model:

04750-0-015

ADC Modeling 7 + — 2 C[Device] ¥ 7% IR L, ¥4 70
TRy AOKIIH D [L] Ky rer)y s LET, 77
AN TIIFENREE, F74NVbE - T4 L7 NIHILH
LAETVPIRTERENT T, EF VT vilu—F
LTWARWEAIZ, [ A =] OAF v T1E2SH L
TL7ZE W,

REV. 0 — 15—
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5. 774N - TIPS ETIVEERL FT,

Open
Look in: [ (=5 Models | ~EcFE
My Recent
Documents
-
L
Deskiop
My Documents
My Computer
- Fie name [ADB645 adc = Open
==
My Network  Flles of type [ADC Model("adc) = Cancel 5
3
Places o e S
g
5
3

ETNEERTLE, TN ZACHETLHEHRP[ADC
Modeling] 7 + — 4 12# Z3AF 1 F 3, [Characterization
Jitter| Ol (BRI ISPt S iL7-fl) 25, [Input]¥ 7D
[External Jitter]’K v 7 A IZHBIMIZIHFA SN T T, $72, E
TN & 5 T[Output Mode]DfiE & L T[Offset Binary] & 72 (&
[Twos Complement]D &5 LA FRENT T, ZOREE,
Config >FFT A = 2 — CHEIWIATONTE T, ETIE LI
EBEDO TN ARG T 5841, [Output Mode] D% E 25 1E
Lw2rk <EEL £, Config>Windowing A =2 —Dw 4 ~
R BA%AS[None | 12 5%5E ST % & | [Coherent Sampling]
TAYRYDBHEET, BT Y7 E— R Z ORI A
L7234, [Initialize] R 7 ~ 230§ & FHE S =@k EH
[Input] ¥ 7 ®[Analog In] K v 7 21T A SN E F,

25y 7ba

=& ADC Modeling

Device | Input |

Pleaze select pour modsl;

Part Mame: ADE645 Rewv B

M Bits: 14

Encode Min: 30M5PS

Encode Maw: 105M5PS
Latency: 3

Commaon Mode: 2.4%

Input Span: 2.2
Characterization Jitter: 0.15p5ec
Jitter: 0.05pSec

Output Mode: Two's Complement
todel File Yersion: 1.0
Modeling Engine Yersion: 1.3.0

04750-0-052

6. [Input]¥ 72 #ERNLFF, COF¥ TTEIRTEZLHDIE, ¥
YIUNETAR2 N = Y D ATWI. Ty oN— ¥ O ATIEITHE
HzLiEL 52 ANEFLNV, ANEER. B4 7
vty b, BELVYI, Ay s - Uy sy ERICHER
7Has - FATT, 2= EER LA, 20H
D=L BRRNTEFT, b IEMELFBREELITE, 22
DEFVFELFAFAD - =T % ) A,

27y 76

¥ ADC Modeling [X]
Device Uput |
| Sine Wave _'_J

mpliuge; 11 4BFS
Analag ln: 12.2—‘MH2
Encode: ISU—‘MSF‘S
Cormman bode: ]— )
Input Span: 22 B
Esternal Jitter: IFDSEC
External Dither: IU— W

04750-0-053

7. 2N TModel DFEEMNET L. FFMiABGL T, F¥a A
¥ MZRIE N TV A ADC AnalyzerDBERE % i 2 13, FERB
DOFA A — FEZEHEL TV ARG LR L) 2N —F ¥
VR AR — FORBRATE 5, /N —F ¥ VERfli R —
Fid, 77 AP VRNVERERDOAAL —T % K-}
LTwET,

8. EWEOBMOFHMIZHE A 412, Config >Bufferd I 123
LTy 77 - AE)ZHEL, FaYTFo > - ) A D
22 H[HSC_ADC_EVAL] % #IR L TL 728\,

— 16— REV. 0



HSC-ADC-EVALA-SC/HSC-ADC-EVALA-DC

ADC AnalyzerD#%gE

FIFORFAiffl 4 — N CIUE L 727 — 5 1T LT & 3 5% Rkt
FEFTEET, INOOEREIL, TVF Yy - A=2—DF
DERY Y TERENTWET, Analyzerd 7V ¥~ - A
Za—hOLLFEUHERRICT 7 ATEE T, DTIC, &Ky~
WKOWTHBHALES,

P ] i

COREIZ, ¥x T v - T — ¥ Z T
EL7ZbDFRLET, BHokiliciz, T
OMPFREINT T,

AVCC : Config>Power Supply Cik%E L7277 H 7 HEEL N
Vo (FIRDH)

DVCC : Config >Power Supply Ti¥E L727 Y ¥ VEE LN
Vo (FEROR)

Encode : Config >FFT T L7ADC> 11 27-L — } (MSPS)

Analog : Config>Windowing @ [l [fi %> & [Initialize] & #1172 %>,
$ 7213 [Input | B i 2 5487 S M7z 7 1 77 AT H
%% (MHz)

Min : 7127 AJNCE o TRSNR/ME T — F

Max . 7+ 07 AN Lo THRONRKIIa—F

Range : 7+ 10 7 AJJI & o TR SN 720 — FOHFH

Average . I — FOYV¥fE, aE>Y - E— FEMTEET,

F/S : 2% L7 VA7 —)b - a— FiF (niz¥ v M)

Samples : FFT Configuration (Config >FFT) T L 724 ~
TVE

S

COREEEF Yy TF v - T RIS A
L72bDEFRRL, VI TN a—T4 271
DAETE LT, EHIR KT T 25461,
[StoplR% > % 7)) v 7 LET,

FFT
COBRRIZ, YUV =Y - TFR T AND
= BT D722 F vy T F v - F— ¥ % JMk
HAELLDOZEFRRLET, BroLilizix,
TROMEFFRENE T,

AVCC : Config>Power Supply CikE L7271 7B LN
v (FROH)

DVCC : Config>Power Supply Ci%E L727 Y ¥ VELE LN
Vo (FIRDOH)

Encode : Config>FFTCi#% L7ZADC7 1 v 7 - L — b
(MSPS)

Analog : Config>Windowing® T 2> & [Initialize] & L7z %>,
F 71 [Input) W 2 S 38E Sz 7 F a7 AHEMEE (MHz) .
IF 7Yy 7-77)r—32aryCid, 7827 ANEaHE
ENTRMDF A FA D= VIZESNE T, Config>FFT #
Za—TIZya—=F- L= R LS RETHLENHD £,

SNR : S/NIt (dB)

SNRFS : S/NIt 7 )V A% — ) (dBFS)
UDSNR : —H5EF#NS/NIL (dB)

NF : / 1 X{8% (dB)

SINAD : 5%,/ 4 R&EH (dB)

Fund : 3589 (RAfE5) © L)L (dBFS)

Image : 4 x— ¥ GEE#E) ATV T ADL N (dBe)o A
A=TWE, TRV T LY 2 NE L7ZADCEEHT 5 L&D
AHERTT o

Second : FEAH I D2 EF W D L X)L (dBe)

Third : JEAFEHOIKEHREO L)L (dBe)

Fourth : 2RI O4KEREO L~V (dBe)

Fifth : SRR OSKEHE O L~ (dBe)

Sixth : HEAF BRI OOKEMP DO L~ (dBe)

WoSpur : i EIERERIEA 7)) T AD LX)V

THD : @il EH (dBe)

SFDR : 2 7Y T7A7Y— ¥4+ 3Iv 7 LY (dBe)
Noise Floor ;. / £ X - 7u7® L)L (dBFS)

Samples : FFT Configuration (Config>FFT) TiEs&L 724 ~
TVE

EIULFFT

i COREIR, EHRFFTZFR L £,
EHFFT

koo COREEIE. - TFIREDFFTHROFH %2 ER L
k %9, FFT#uUE. Config>FFTCHEL 7. 7
7 4 MBEIE5TT,

SEHTHFFT

COREIL, 1 —FIREDFFTH O E Y % 3
MMM R 9, FFTHZ., Config>FFTT#HE L 9,
77 %)V MEIZSTY,

REV. 0 — 17—
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2h—>
ZORAEE, 2h =2 T F BRI A ORIOL
= WIZF Y Ty Ty T L7
bOXFRLEIT. BHEOLEMIE, FRofl
DEIFENET,

AVCC : Config>Power Supply Ci¥% L7277 H 7 EL LN
Vo (FIRDH)

DVCC : Config>Power Supply CixE L7727 Y ¥ VER LN
Vo (FIRDH)

Encode : Config >FFTC#%E L7z ADCZ 1 v 7L — | (MSPS)
Analog 1 : f#)® 7 F 1 7 AJjE#%E (MHz)
Analog 2 : 2FHO 7+ 1 7 AJEEE (MHz)
Fundamental 1 : i #) D573 (dBFS)
Fundamental 2 : 2% H O AP (ABFS)
F1+F2 : 2RO (dBES)

F2-F1 : 3ERW 0% (dBFS)

2F1-F2 : 2X3EARYE 1 — FA9%2 (dBFS)
2F1+F2 [ 2XHAP 1+ A2 (dBFS)
2F2-F1 : 2X AR P2 —FAP:1 (dBFS)
2F2+F1 [ 2XHA P2+ A1 (dBFS)
WoIMD : S AR A HTE A (dBe)

IIP2 2R HZERERANT —IZHEST L AN 7 -7
b EBA Y FORIES (dBm)

IIP3 : 3R AL ERNT —ICHET BATA ¥ 5 —& 7
b FA Y P OFERE (dBm)

SFDR: A7V 7 A7) —-%4F3Iv s - L (dBe)
Noise Floor : / 4 X - 7u7® L~ (dBFS)

Samples : FFT Configuration (Config>FFT) T®E# L 724~
TNE

E2 b—>

i Z ORI, EH2 N — Y FFT28RL 5

T2 b —2

ZORREIE, T—FIRED2 I — YFFTHOFY
H 3R LE3, FFT#uUZ. Config>FFTCi%E L
9, 774 ) MHEIZSTY,

®Y

@ CORYEy) vy LCHEERRERE KT
Lij_o

F—ADX—LETY AKR— B

FRENLTF O/ ESE L IEFFTO—H 2Kk T 5121, <
YADERY YAEMLI-FE, BUTLEEENT v S LT
BO—HERINLE T, FFFRRDOA =2 —2FIRTHI2IE, 7
JFA4T A Y RINTYIADERY v %27 ) v 7 L FE
o FERROXA =2 — 1T, Bld 70y M EFFT7H Y Ol
ETHVLEZVIET, TNOHD A= 2 —|21F, X — LFEERH:
a7 — 5 DT 7 AR— MERER EVWLODhDF T a VD
DET. A7 avid, vVADERY VCRINCTETT (M
7. 8% M),

H-Zoom H-Zoom
¥ Zoom B Zoom
Exact Zoom Exact Zoom
Restore Restare
Spawn Spawn
Expart Data Export D ata
Cammetts Comments
Lock Data FFT Data‘Write
EC1 Transition | Bin Boundries .
FFTBins | FFT Bins | 3

X7. EEE7TOY bD
FERRAZ2—

X8. FFT7’Oy kD
FRRAZ 21—

H-Zoom : #EIR L 7513 % AKF AR L £ 3,

V-Zoom : R L 7= 58 % Tl T IANICILR L £ 9,

X-Y Zoom : KFB X OEEFINICIRL T (2K90),

Exact Zoom : FFEDEEREE AT L TFERLE9,

Restore : 77 7 % LOERIZEL T,

Spawn . 77747 -4 Y NUDEMRT—F 7 - a—
EHREEL, ZNEfEH L CHOMITEEITTEET,

Export Data : $XTCOF—% - K4 > b EFHE LR ZE
TrANMICESAAE T, HHld.csvy 7 AV TRIFS N,
Microsoft Excel CFE/RTE £3,

Comments . 77 72T 232Xy N2 ANTEF§, FFT%
FIRIS 5 & 213, axr Py —flIcEEanEsd,

Lock Data (Kffjli7 o> rdR) . 7— & OB >~ 7
EMot2b, #FOF—4%% [y s | L<C, FFT29%{7C& %
¥, FETIZ, HiLWwF—% - F o T TIERL, TOF—4 12
EOWTEHHESNE T,

— 18— REV. 0
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EC1 Transition : fE%)

FFT Data Write (FFT7 1> FD&)
77 ANVICEZART T,

Bin Boundaries (FFT7 Ry FO&R) | AR & @ilgk o
VFE— ORI T 5 C v 2 5mil#R L ¥ 9, Config>FFT
T »[Fundamental Leakage] & [Harmonic Leakage] % i%5E L &
o RN, [FEMHA— FORE] 2L TS0,

FFT Bin : 77 7 OXu#l & FEHr b € VAT L £,

T—=EDA R—h

75— % % ADC AnalyzerlZ{f ¥ R— » LT, FFTRIE % %17 T
XI3, 2MEOF— Y E A4 FE— N TE T, 10D AE
OBRJE T F AL - F—% (L2, BV vy - TFIAHY
PHDT—%) &, ADC Analyzer’»5H L7 AR —+ L7257 —
57'(\\1;_0

T—8 %A YR-bTDEEE, Configh=2—TE v ML,
FrTN A FTUY VX Qowigrt 7y b
A7) FELGERSNTWD L2 ERLET,

ADC Analyzer» b 7 ZAR—L72T—=8 %4 Y K—1+32
PIREa

1. File>Import Data® 12 R L £ 5,

CRHE L7ZFFT T — %

2. MOIZIRLAZFATOTERY 7 AT 7 ANVDINA%E AT
57, [Browse...] K% > %2V v 7 LTI77A4ANVEHELE
T, [OK]2 27D v 7 LET,

3. BB T — Y O T I LW 4 v RO RENE T,
FOTFGTRAEY) v 7 LTHEFRDAZ 2 —%FR LT
T, A =a—75[Lock Data]# #IR L T3, [F— %D
A=LbT 7 AR=1P] OISR TLEZE W,

4. ZOFT—= Y OFFT2F473 51213, [FFTIRY > %2 ) v 7
Lij—o

RO E T F A~ - F—7 % 10EERTA v R= T 5%
bE

1. File>Import Data% #R L 3,
2. K9IZ/RL7-[ASCII File] X% > %27V v 7 LE3,

3. M0 4 Y RyHHELTT, TOY A4 FYT, 7%
b 7F=% - 77 A NVOBRGEICHET 5EHZADC
AnalyzeriZ5-2 522 LD TEE T, AT A=FDER
PRS- TWD L BT — % LFFTT— 7D b 5 B 1
LWbDiZidnh FEA,

Data Bits : ADCO 5 fiffe % I L £ 9

Samples . 7 7 A VO > TV O ERINL 3,

Data Format : ADCH /)7 — % O #IRL F 5,

Justification : % . ADC Analyzer’>H L7 AR — b &z
T=ZIE . MSBHIZ SNE T, T—F A v FR-bF35LEI,
P L WALER 2 &2 IR TS,

Encode Frequency (MHz) :ffiflsnh7=%> 7y 7 -2
Oy sz - L= 2 ANLET,

ASCII Text File to Import : [Browse...]’K% > & 27V v 7 L
T77ANVEHELET,

4. [OK1z 27V v o7 LET, BET—7D 77 7058 Lw
TA Y FTICRRENET, EOT T TELI ) v LT
FEFEROA =2 —%F£RLETT, A=2—25[Lock Data]
TERLFET (NT22H),

5. 2OF7— Y DFFT2 %479 51213, FFTKRY > %227 1) v 7
Lij‘o

B(=1ES

&, Import Data

Comma Delimited [ o] File to [mport

Browse. ..

Cancel ‘

bk A5CIl Fils

04750-0-021

9. [Import Data]# 1 787Ky 7 X

| Import ASCII Text File 8li=11E9

Data Bits |14 j Samples |15334 j

D ata Format Justification
 Offset Binary  LSB_Justiied
&+ 2's Complement = MSB_Justified

1E-8it =

[~ ComplexDala

Encode Frequency [MHz) |65

ASCI Tewt File to Impart

| Biowss

0K | Cancel

H

X10. [Import ASCII Text File]5 4 707K v 7 X

.csvZ 71IVLEASCIT 71 I

E11ix, #~<~EFWh D774 NVIEX (esv) %Microsoft
Excel TER L2 DTS, .csv? 7 A WIZid, AT —
et IhONTA—=FH A>TWET,

REV. 0 — 19—
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W] oe ot Sem et fovet Tk Oen B B0 e

"l SRY shn- I sr-lmgms -0,

i cE.m s EENE SR, 43 EE -S4,
A ek wdwaiin e e e
W E 5 [ E F & W T ] 3 T u i T =

1 -

7 Cowvace bt Arusiin s Enciode Fit Aumiage 5 Max [ Rarge  Samplies A D MsxTarw DibsTeme Yh

3 i Apee r 3 e g s 8G

3w

5 6ue

& asu

T

(T

R

W s

a0

G nm

6

ijk&z‘:asazz:ﬂzuuzz;a;‘;n
8

§
04750-0-023

ADBAIOTI 151 | ol
s

X11. Microsoft Excelil& .csv7Z 7 1ILDA K- b

77 ANVDO—%F EDFT121E, RawTimeData (4= E;[E#h 7 —
%). Device, Device Number\ Analog Frequency. Encode
Frequency, Average (F¥fH). Bits (€ v M), Max (K
fii). Min (/M) . Range (fEO#iPH) . Samples (4 7v
). AVCC, DVCC, XMaxTime, XMinTime. YMaxTime,
YMinTime, Date. Time. Device Temperature, CommentsZs
EDRT A= DB FT,

ADC_AnalyzerlZ {4 ¥ R—N§ B.csv7 7 4 VELERT B%4.
T TNDesvT 7 ANDIBRIHE ) LEPH Y 3, Excelx
FHL, DELRT =Y ENRT A= 2T =% /T A =5
BED AT T 728w, 728 218, 1638404 > 7V (16kBH >~
TN) DB, T I VvoRE (16384) % [Sample] @
VDT CTORMVIZEDFITE4, KIT, 16384 D ED
F—% - %7 V% [RawTimeData| @+t )LD FIZHEY 1)
T4, LETHNIE, E3HLD/IXT A—F % [Samples| ®
[RawTimeData] O L H IZEHTEF$45, LT LD ZFONLE
XY FEA.

LREOTIMEIZ, Excel i3 4D —F#HE T, csv7 7 1
WIERAEIRGEDTFF AL -7 1 F TR TE A, A EIR
TIMI2I1Z7RT & 9 RExcelll® AFIDO LTz DI TE Ao

Ve Bt Feme e fwe

‘BamT I me0ata”, “Devie, g B ey M L R i Myt B i
Ao T A I H v WPy A e A e N i A e o P M S e s 1 St
208

SR S

EF

I
it
o

28
90

04750-0-024

< I

12, X ERICEBASCIUTF R b« T7AILDA K= b

ADC AnalyzeriZf ¥ F— FF5ASCI7 7 4 VIEX Tld, £D
Bl 7 — 7 OAZMH L 3, 2hlitozAd8E. el
WO gE, AR=A, hr=, ¥71E, ZOASCIH7 7 4 VT
3R IR A

ASCII7 7 A VBl : (ASCII7 7 4 VEARIZZ D X 5 e
s SV TR STV ET,)

B TestFFT_Time.txt - Notepad E]E]

Fle Edit Format View Help

38684 =)
32512 3
26352
20484
15172
10648
7116
4748
3640
3844
5352
8092
11944
16724
22240
28236
34416
40536
46308
51460
55772
59052
61148

|

04750-0-054

X13. ASCUZ 71 IDH > T

EN R

ADC AnalyzeriZl3W <O OHRIA 72 a vy 05H ) 5, 7
7547 914y Ky aHRIY A121&, File>Print >Print
ActiveDIEIZEIRL T3, HHEOF—T ¥ - o4 ¥ K %EIRI
9 4121, File>Print>Print ListOFHIZEIR L F 5, FRSh
e ATaT Ry 7 AT, HRT 5714 P2 @EIRTEE9,
BB DY 4 ¥ PO &R 2813, <Ctrl>F — %3 L 2%
5% 4 v Ky & ERT 25, [Print AR > TFXTO
F =T -4 Y FYERERILE T, WA R A2
File >Print>Print ScreenDEIZ# IR L £ 37,

w, Select Forms to Print

X

FFTA Data  Date: 04-05-2004  Time: 12:31:33 Temp: 28°C 1
Timed Data  Date: 04-05-2004 Time: 12:31:28 Temp: 25°C
TFFTA Data  Drate: 04-05-2004 Time: 12:31:35 Temp: 25°C

Frint Selection

Frint &1l ‘ Cancel ‘

04750-0-051

X14. HRA 723>

REV. 0
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7 74 IVDRE

ADC AnalyzerTld, 3@ ) D/ETA A=V ERFTEET,
TIFAT -4 KRy by TR T 2 djpegB T
A3 51213, File>Save As>Save ActiveDIEIZRIN L F 4,
KA =T 4 Y FI ROy vy T - T AL L
THRAF 5121, File>Save As>Save ListDJEIZE#IN L 3,
Wimekz Yy bvy 7 - 77408 L THRET LI,
File>Save As>Save ScreenDJIHIZEIN L F 37,

ZDMDIERE (/N—F v JLADCDH)
ROFBEREIX, N—=F v VEHiH AR — FOREREEZ M L T\ 535
GOARFIHTETT, TOMKAEX, BEO/NY 77 - XEVIE
BCHEE L T b & ERERI T,

&Nl ADC Analyzer Version™ 4.4.1
File Config Analyze JEE=:8 Window Help

Analog Frequency Sweep
/\{\} | :}’:}‘." : Analog Amplitude Sweep L | . | i H §
2

X15. ZA—TF-EFE—R- T3>

A VA Z 2= 5[Sweep] & BN L 9, ZHiZid, [Analog
Frequency Sweep] (7 715 7 JH )% A 1 —7) &[Analog
Amplitude Sweep] (7 1 Z4RIFA A —7) O D Y 5,
WINPEEIRT 5 L RET 1 Y FUDHE 9,

7FOTREZR A —F (JN—F v JLADCDHH)
COF Ty arEERTLE KIOIKRT 7+ — APFKREN
T, ST — LT, FIEAL—TDF T a v 2 @R &
T ZOBEDE WL [Input] ¥ 7 D[ADC Modeling] 7 + —
LATHREL, RICAH T a ry2@IRLTL S0,

& Amplitude Sweep Configuration

Ho

,_1—
m
.
o

Start Amplitude [dB] [~ SFDR vz Amplitude
[~ SMR ws. Amplitude

[~ 2nd Hamonic

Stop Amplitude[dE]

Step Size (dBm) I~ 3rd Harmaonic
[~ 4th Hamanic
Reference Ling ;
I~ Bth Harmanic
I~ Bth Harmanic

SNR Reference Line
I~ 'wiorst Other Spur

[T Resultz FullScale
FFT

[ Datalog to Disk
" Awerage FFT SEE S

v
& Singie FFT [v Datalog to Screen
™ Datalog Plots to File

[ Datalog Plots to Printer

[u]: | Cancel

16. REXA—T - E—KDF T3>

04750-0-055

Start Amplitude (dB) : RIEA A — 7OREL NIV 2 7%EL
F9, TNIET U N—=FDDCTI VAT — ) VEIkiEL L TnFE
To COMEIE, LIHRTLANVORIFL D NS KT LLEDPH
NEd,

Stop Amplitude (dB) :IRIEA £ — TOKT LNV EEEL
T, TNEFEI U N=FDDCT VAT — NV aRiltl L TnFE
T CoffilE, LPBEBELANLVOERL ) KT 2ULESD
hET,

Step Size (dB) : &RIFEAT v TIEHT L2 AT v 7 - A4
Xy WIZEDEIZLE T AT v 7 - A4 RXICHIRIEZH Y T2
AD, AT THNEL B be, AL =T T3 5FTOR:
BPESHRDES, /20 AT v ITREL D E, A4 =T
D5 RREST L £ 9,

Reference Line : SFDRE O HEIZMHHTH) 77 L VA - T
A UMW ENFE T,

SNR Reference Line : S/NIL & DILEICHEHTA2) 77 L~
A - TA YOHESNE T,

FFT : FFTO#RIZ L o T, A A =7 HIZY ¥ ZVFFT &2 14§ )
By CPFFTZ ) A5k ) £97

SFDR vs. Amplitude : COF = v 7Ky 7 A& #IRT 5 &
SFEDRAHRIGDH RS FR SN E T

SNR vs. Amplitude : COF = v 7Ky 7 A% FER]T 5 &,
SINIHHRIE DR FIRENE T

2nd Harmonic : 2OF = v 7Ky 7 ZA&EIRT B L, 2K
FPSHRIROB R P FIREN T T,

3rd Harmonic : COF = v 7Ky 7 A %@INT 2 &, 3KEH
PHRIEORE R REN T T,

4th Harmonic . COF = v 7 Ky 7 A% @IRT 5 &, AKEH
WAHRIEOFE R FIR SN FE T,

5th Harmonic : COF = v 7 Ky 7 A% IRT 5 &, 5KkEH
PWAHRIEORE RS TR SN FE T,

6th Harmonic : O F = v 7 Ky 7 A% EIRT 5 L, 6K
BAHRIEOR R DIFIR SN E T,

Worst Other Spur . ZOF = v 7Ky 7 A%ERT L&, £
DDIEA T 7 ZRHRIBORER A F R EN T T,

Results Fullscale : SO F = v 7Ky 7 A% #EIRT B &,
TOFHMDS T VA = VAR FEBIZL2D12% ) 9 (dBFS),
INEBRL2ve, sHEETE2AEICLZbDICR D E§
(dBc),

Datalog to Disk : 2D F = v 7Ry 7 A% ®RT L L, §C
DTF=IWRTT7FNVEDT—5 - T4 L7 F)DT 7 A IVITH
EihFhEd, 7— 7 ERUIASCHTHH L HERCSVT 7 1
VT,
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Datalog to Screen : ZDF x v 7 Ky 7 AZEINT B &, X
A=TETHRIS, BELET Oy PO T 70 WHICFIRS
hi‘a‘o

Datalog Plots to File : 2O F = v 7 K v 7 2% ®INT 5 &
KE Y Ry T Oy RBFT AN RDOF—F - F4 LY
JICEZRAINT T,

Datalog Plots to Printer . 2O F = v 7Ky 7 2% ®INT 5
L KEY PRy T - Tay MRS U HICEE ST T,

7FOTEREA(—T (IN—FvJLADCDH)
COFTvarEERTLE, MITIORT 7 4 — L0 FREN
F9, COT7 5 — LT, FAEBAA—TOF T a v aBRL
3, ZOHEDORIE Input]y 7 D[ADC Modeling] 7 + —
ATHEL, KICH T a v 28R TS,

w Analog Frequency Sweep Configuration

Start Freguency Sweep [MHz) 21
Stop Frequency Sweep [MHz) |5

¥ SFDR ws. Frequency
I~ SNR vs. Frequency
I 2nd Harmanic

Step Size [MHz) 0.25 I 3rd Hamanic
|~ 4th Hamonic
Fieference Line a0 [ cib Hamoni
I~ Bth Hamanic

SNR Reference Line 70
| ‘worgt Other Spur

1717

Amplitude Lewvel
T~ Results FullScale

~FFT-

" Average FFT [ Datalog to Disk

* Single FFT ¥ Datalog to Screen
[ Datalog Plats to File

I Datalog Plots to Printer

1] Cancel

04750-0-027

M17. BEHEXA—T - E—-—KDA T3>

Start Frequency (MHz) @ WA A — 7 O BIGRE B 7%
ELET. ZOMEIE, LFETLARVOIRIFELDNS T DL
BEoH ) T,

Stop Frequency (MHz) : JSUHA A — 7 D# T JE % i%
ELET, ZOEE, BTRBLNVORIEL Y KRELT L
EhdH Y 7,

Step Size (dB) : HHWKAT v 7l T AT v 7 -
A X, WICEDEIZLET. AT v 7 -4 XZHIRIEH Y F
AN, AT THNEL b, AL-TE2ETTAHETD
R RC D ET, $720 AT v THREL LD E, A —
TOFREEDPRT L E T,

Reference Line : SFDR & O LI HTA2) 77 LV A - T
A UDEmENE T,

SNR Reference Line : S/NItL & DI+ 2 77 L~
A TA YDHEENET,

FFT: 2OXy 7 ZADB{IRICE > T, AL —=FHIZy 7N
FFT %89 70, FYFFT#f 9 2h5kE 0 9,

SFDR vs. Frequency . ZOF = v 7Ky 7 A %®INT 5 &
SFDRAJE B E DA R FIREN T T,

SNR vs. Frequency : 2O F = v 7Ry 7 A%ERT 5 L
SINICH BB DR R FIRENE T

2nd Harmonic | COF = v 7 Ky 7 A %8RS 2 L. 2KkE
PP E ORISR ENE T,

3rd Harmonic : 2OF = v 7Ky 7 A %8RS 5 L 3KEH
W B R DOFERP IR SN T T,

4th Harmonic : ZOF v 7Ky 7 A% ERT 5 L K50
Wt R B ORI FIREN T T,
5th Harmonic ;: COF = v 7 Ky 7 A %EIRT 5 &, 5KEH
Pt ORI TR ENE T,

6th Harmonic : O F = v 7 Ky 7 A% BIRT 5 &, 6kEmH
W B DOFER P IR S NFE T,

Worst Other Spur . ZOF = v 7Ry 7 A%EIRT L&, Z
DMDIER T 7 A AW DIERPFIR SN E T,

Results Fullscale : ZOF = v 7 Ky 7 A% #EIRT L L, X
TOFHMD T VA — )V & FEHEIZ L2 b 012k ) £3 (dBFS),
INEERL e, FHINIGES 2 EMEIC LD 0122 ) 5
(dBc)

Datalog to Disk : ZODF = v 7Ky 7 A% |G 5L, §XC
DF=FIRTT+NIDT—=5 - T4 L7 b)DT 7 A )VIH#
EhFEhFEd, 7= 7 ERIFASCIHTHMH LR CSVT 7 1
VTT,

Datalog to Screen . ZDF = v 7 Ry 7 A% BN L L, A
A—=TRTHIZ, BELALEZETT Y bOJ T 7HMEIZFIR S
nFd,

Datalog Plots to File . COF = v 7Ky 7 A% IR 5 &
Ky A=y T - Tay MR T IV INDOT—=F - T4 LT b
JIZHFEAINT T,

Datalog Plots to Printer . 2O F = v 7Ky 7 A% ®INT 5
LBy Ry T - TRy MET) Y ICREERET,
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NI a—FT127

729 b -4 ESHPERREND

. Bus Check

Charinel A: ]

Channel B:

# - Switching

- Bit Stuck Low
1 - Bit Stuck High

Channel & [soaatadadatadan <
Channel B:

# Naot Tied to Either Bit
< Bit Tied to Bit Above
> Bit Tied to Bit Below
= Bit Above=Bit Below

04750-0-028

(18. 12y NADCONZX - Fr v ¥

YUK DRHEER Y Y27 ) v o Liztk, U4 Y FUICER
SNTAEEDT Ty b T T,

1.
2.

REV. 0

HROERE T v 7 LET,

USB7 —7LV2557 4 — b (1.5m) LW ELRVHR, HbH 0
ENF LV - Ty s - =T VHIEEE-1284 HiftD 7 —
TNPHERL E 9,

PCEFIFOER— FHDr — 7 VR ZF v 7 LT, 72,
Config>Buffer®JHIZHEIRL T, IEL VST LV - F—}
(LPT1 % 7213LPT2) 25N SN T2 2R L £,

NT LI - K= EMALTWALEIE, a0 E2—%D
BIOS ®Printer Port*[Standard Bidirectional]lZ7% & St
TWAIZERMERLET,

. Channel A, Channel B, 7213220 F ¥ » £ VO 5 A%

Config>FFTTEREIN TV A I L 2R L E T,

st F 2y 7 L, 20y 2 SADCEHEA A — Kol
INAES B 2 L AR L £,

. FIFO &£ ADCFFii K — N OFfe s T 7 — 2 € b

BAMTONTVDE I LR LT T,

Analyze >Bus Checkt 7> a Y #flifIL., §XTHF—%
o bOYIYBEZPTDRTWE I ERkERLE T, K18
3. M4y PO YTV - T YR NVADIT NS
AD6645DBI %R L72b DT, JE LMoY v FHMSB
‘(“j_o

9.

ADCOT—% v — 2L, ADCFHiliH A — F Eo3x
TOV v Y NERPIELCERE SN TV D 2MERLE T,
ADC/ST — ¥ v« k7 a VIZER % 5 TWARLEN
HHET,

10. F22 ML, T RTOT v Y EERAFIEL CEESNT

7

V2 BRERL T
FTATARERBZBWESHRRENSD

04750-0-029

X19. AZWLIFE#MTOY b

¥ U4 [Time Domain]& 7 V) v 7 L7z ICER SN B ET
D7 FO T ATEFOLIICITRZTTA,

1.

EHEOEZEE T IE, K190 X5 ICKEREY «+ >~ FYNT
RWTHy Z7DEH)ICHZET (FRINDEZEOEA
B o w14 v Foatiz) vy 7 LTHERDAZ 2 — 7l
& BRI Ry EMTE s L TE T,

PCLFIFOKR — FID 7 — 7 Wk a7~ v 7 LET. F72.
Config>Buffer®JHIZHEIRL T, IEL VST LV - F—}
(LPT1 % 7213LPT2) 25N SN T2 2R L £,

Brogst =y 7 LET,

Analyze >Bus Checkt 7> a V&L, §XTHOF—%
Ey bOYYEZ BT ONTVE I EEMHRALET,

Config >FFTC[Twos Complement]:R % > A51E L < J#IR &
NTVWBZLZMBLET. ZOKRy 7 ANERE N TW
TH, ADCOIMIA2DOMEILRIZ > T & Rl
Ty FHR20D &) IFRENDLGENH D T,

T=IDBELLMYAENDL EIHICIA IV T2 LE
Fo FFAIE. TEMEREIE] o [0y 7 0FH] L&2%%
LTS,

BIERER T Fa 7 AN (728 213, 0.1~1MHz) #fEH L.
YAIIUMER TNy Z LET, 1094 7 Vs EIEME
WA NV EEL DI, (10XTS)YMERLTAET, T
T, fs=x v a— FEEER M=% 7L 314X (2Y)
/C\\?_O

TR T ANETORCERT =5 2@, TFa AN
IEVE=F - LRXVIHEP WA T v 7 LET,
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04750-0-030

X20. 2DHHMOMEE 5 1-3TE

FFT/ A4 X - 707 FRKUEV

21.

—

e .-. 4 ' J i

ey | |mr
:;t.tit;;f_-MM}"} i Hr i \| ||

LG

04750-0-031

24BN /AX - TATICRIZTREDH

SFUF FFTO /A X - 708 7HTFHELI Y KX oTn
¥¥, FFTTFEO /A X - 707 L) KELBBHDIE, 7

oy 7

CINADEA IV TREDPEEIC R o> T 2 RN H

DES,

1.

LV v8I3048 L U5 F 72130305 % Bl E I

. U30204fHOXORT — b & ffio Trm# s 1 v 7

LS LI CIGEREE R AT ) 21T,

ADCIZEIGEDIEZFERES (72 21, 0.1~1MHz) % A
JL., o7y bERBLET, 70y M0
IITHNE, ¥4 IV TIMESH Y 9,

AT
sy s ZRELET,

- RATE
WEEFFATEH, 70y 7% KEELTY A 3 ¥ 7% ol
TEET, Vv o 8I314L1315% BIOMEICRE) L TH T
FTo DX BREMHTH, TNITL>ThR Y FTIKIZH A
IVIRABTEET,

FEEINTWS MY
2 - Ry FR3I2ERBISZHHALE T, 774 bDINA X
AXRTCICETICIE, Iy - v »8]310~1313%
Y BB H Y £,

FFTOXRZHZATIF7 R

(1 X — ORE)

04750-0-032

Ok LCancel

04750-0-033

[23. F v > xILDEIR

YFUA TRV F T LT (AD94307% &) &R T 5

& X2, FFT (ERPE DA 2 =)

WCKRER AT T ADAFAE

Lij‘o

1.

. [Interleaved Priority] X = =2 —

Config >Channel Select®JHIZZ ) v 7 L, K231Z/RL 72
w4 Y K% & 3, [Interleaved Data] R v 7 A A3EER
ENTVLZEEHRLIL, [OK1Z27 ) v 7 LET, V
7 v =7 OChannel Ald, FHiliH K — FO TEHOFIFOB
X OFIFORIE X D F v > )V 1IZHY4 L ¥ 97, Channel B3,
FHIH AR — Ko EEBOFIFO (Analog Devices® B T2t
VD) BLUFIFORIEH DT v ¥ 2 V2124 L £ 3,
FEMIE. [P v o8] 2BHLTLZ8 0w,

Tl¥, Channel AZ 7-1%

Channel BOWEFNPIZF = v 7w — 7B fnwTwnE 4,

REV. 0
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3. JIOFFTZ2FEA7 LT3, AT U T ADHERLIETTY,

. [nterleaved Priority EE

Wwihich channel is interleaved data zent to first?

" Channel & {* Channel B

X24. [Interleaved Priority]* = 1 —

REEE D 5 ODMSBDEK

REV. 0

04750-0-056

X25. Ev b+ YXTDOEES ZEETE

04750-0-034

2F A D 20OMSBAREEN T Y M HHZ TWE T,

1. AD9200, AD9201, AD9280. AD9281 % &FHii§ % & i,
Config Bits>Data Bits Ti#itJ 22 ¥ v b 2SERE TV % H
R L E T, AD9200& AD9201 DAL v M13~4,
AD9280 & AD9281 DI AIFE Y MI3~6%EIRL ¥, 2
NHEDOADCOT 74V FOFEE7 714Nk, ADC
Analyzerk L 124 VA M=V ENFET,

2. FIFOa 7 ¥ TE v FOYEZIrbhiTwd 2 & &R
Li@_o

FIFOXEUDT7vy 7L —FK

FIFOFIT K — Ficid, EFIVICIE U CUE F 7213218 »32kB
FIFO» % ) ¥4, ¥V HIOFIFOT v 77 L — F (64~
256kB) &, A VT 7L —FT4 v K- FNA A -F27 /0y —
# (IDT) 5 AFTEE T, IDTONN—=YFEZEILTOE S
T,

+ IDT72V283 : 32kB (#4#%)

« IDT72V293 : 64kB

« IDT72V2103 : 132kB

« IDT72V2113 : 256kB

FEANE. www.idt.comZ S LT L2 S,
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Y AN

Yw Y SOREIIE, BT ONHE B L T {2 & v, FIFOFFMi A — FTld, Channel 113 F#OIDT FIFOF v 7124 IE L,

Channel 213 EFOIDT FIFOF v 7 (Analog Devices® I T2z b\ d D) 123l L TWE

R2. T IXOLH

frE HAR

In Vx yNEE Q¥ Y - A )

Out T ySEE QEY - Av )

Position 1 ¥ 7z (3 Position 3 3 - Ay FONEE/RL F T, Position i FR— FEIZEEEIhTwEd,

R3. NH - TYy IO

@ AR

In N8y Fedm L7,
Out INGT Ny FERFERHICLE T,

F7 4 IU MERTE

#41x, FIFOFHH ¥ v POKET VDT 7 5V FRED—ETT, 7)) - Fx 4 (SC) EFNVIL, THOFIFO (U201) %
f)> 7N Fx Y AVADCTHEHAT A L) ICHESNTVET, 7aT7)l - Fr 2l (DC) EFNVE, TYVFTLrHEN
W L72ADC (AD94307% &) THIHTA L) ICHEESNTVET, TaTl - F¥ Y A NVADCOKEE, ¥ 7 - %v/Z\leADC

UM (-3 FIFODREE, ZhZhElos)

IFERENTVET, AR - R

WCEkoTE, AV T RIELSHET L7720

INLDOBECEEL 2T TR Y A FEE, TEIEEI] o [0y 703 2L TS,

DX SO F AT HESIE NI

Default Jumper Wizard]% 7 V) v 7 L 3, KIC

b Y %9, Help>About HSC_ADC_EVALAT[ADC Analyzer] &= &M L

LM TAET TS = a Y ICEATARER Vv I LET, FOT TN —

. [Setup

v a YHICFIFOR — FODFEREN, ELWI ¥ VOB EITRENE T,
R4, Tw P INDERE
FTAILRD
ST 2T
F o ZILD TFRWFTLIY | FaTI- FrRxID
RN EXTE HA%zEHD FrxID | KE
= (FEB) ADCDOERTE XE (EEB) FiiFA
J101 Out Out Out Out FAdH
J102 Out Out Out Out HALH
J103 In In In In AFTN & H 65 GNDIZHE CGRAETH)
J105 In In In In ASI~ v 75 6 GNDIZHEfE (REE)
J106 Out Out Out Out HAli
J107 Out Out Out Out FAli
1201 Out Out Out Out HAfH
1202 Out Out Out Out HALH
1203 In In In In [A1#% 7> 5 FIFO1 DFF(E 5 % [
1205 In In In In 6] 7% & FIFO1 O EF1E 5 % MU
J206 Out Out Out Out HAli
1207 Out Out Out Out FAli
J303 In Out Out In 425 —=1)—=7B LT 27 VIZk L TOut,
EIRA T Ty 7 OHFFE
1304 Position 3 Position 3 Position 3 Position 3 POS3 : DS990 5D 7 1 v 7 K%
J305 Position 3 Position 3 Position 3 Position 3 POS3 : DS902 5?7 1 v 7 [ iix
1306 Out Out Out Out XOR (U302) 25 DOKin7% L
1307 Out Out Out Out XOR (U302) 225D n7Z L
J310~13 In In In In TRTCONYT - Vv I8N E 5k
J314 Position 3 Position 3 Position 3 Position 3 YA IVITRBIER L
J315 Position 1 Position 1 Position 1 Position 1 54 IVTRBIER L
J401 Position 1 Position 1 Position 1 Position 1 WEN;EH

REV. 0
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FTHI D
T v gn .
F o IO TFRIWVFTLIY | FaT7I- FrxID
AR T HAzHD Frxh | HE
&= (FER) ADCOERTE RRTE (EEB) AR
1402 Position 3 Position 3 Position 3 Position 3 WEN# R
J403 Position 1 Position 1 Position 1 Position 1 J303 OUT : POSI FERF v & b,

L Fa7)b - F 4 Y FUVFIFOR— FTORMIHTE T, SRIFERIIZIZT Y70 - F 1 2 FUTTH, EHEF 7 4L b

ML ET,

REV. 0
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FIFOR— FOEEEEPCR—FOL L7 b
FIFOax 7 %

X26.

FLOAT
FLOAT
FLOAT
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
FLOAT

SN Fr I AT R - ECON—LEEXN

400039
380 Q37
360035
340033
32003t
300029
280027
260025
240023
220021
200 019
180017
160015
140013
1200M
10009
8007
6005
4003
2001

GND

DR

GND
D15 (MSB)
D14

D13

D12

D11

D10

D9

D8

D7

D6

D5

D4

D3

D2

D1

DO (LSB)
FLOAT

(HSC-ADC-EVALA-SC)

04750-0-037

FLOAT
FLOAT
FLOAT
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
FLOAT
FLOAT
FLOAT
FLOAT
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
GND
FLOAT

800079
780077
760075
740073
720071
700069
68 O Q67
66 O O65
64 O O63
620 061
60 O O59
58 O O57
56 O O55
540053
520 O 51
50 O O 49
480047
46 Q45
440043
420041
400039
380037
360035
340033
320031
300029
280027
260025
240023
220021
200019
180017
160015
140013
1200M
10009
8007
6005
4003
2001

GND
DR
GND
D15 (MSB)
D14
D13
D12
D11
D10
D9

D8

D7

D6

D5

D4

D3

D2

D1

DO (LSB)
FLOAT
GND
DR
GND
D15 (MSB)
D14
D13
D12
D11
D10
D9

D8

D7

D6

D5

D4

D3

D2

D1

DO (LSB)
FLOAT

04750-0-038

K27. FaT7NFvx)-2x742 - ECOR—_ELEARX
(HSC-ADC-EVALA-DC)
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PCA— FD[EEE

R502
VCC 100kQ
CR502 L o
1uF
vce S0
¢ =
¢
R501
[1]
00 vee |G
2 ol «| of & 2| o| 2| 2| | ©f v <| w| «f =| o
L C503 w 5| 3|l 5| 5| 8| 3| °| ©| | °| °| C| | °© <]
0.1uF = <l gl of 2 ol 2| of &
HREEEEEEEEEEEEEENEEEEEEE
S8 8B8G0 - S EBBb8838858 Lo
n X X x000000 TS ke
ckouTz F B UFEFFEEEEEESSESSs555s N
r £ NS WB I D OO0 OOOOOOA@ 28
IFCLK B oo0o0o0o00acacaa0aaaan INT4 =
b a oo oa oo R504 24.9Q CTRL_A
RDY0/*SLRD PAO/INTO|E2 . =
RDY1/*SLWR PA1/INT1 83 RERR2099 CTRLB
RDY2 PA2/*SLOE |84_R59624.92 CTRL G
RDY3 PA3/WU2|85_RS%,2492 CTRL D
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RDYS PAS/FIFOADR1 |90 R923.20.99 OFT
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95 75
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117 78
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usBveus A6 PEO/TOOUT[108
E502 120]p7 PE1/T10UT[102
128 ps PE2/T20UT 110
1271 po PE3/RXDOOUT {111
1281 a0 PE4/RXD10UT[112
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2112 PE6/T2EX |14
213 PE7/GPIFADRS [115
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o = 5SS 16
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(#EZ)
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